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What this exercise is about 
WebSphere Business Services Fabric greatly extends IBM’s SOA based BPM platform to 
support a new class of applications. WebSphere Business Services Fabric includes, uses, and 
extends IBM’s J2EE WebSphere Process Server for integration and automation of enterprise 
business processes. This new class of applications is called Composite Business Applications. 

The components that make up WebSphere Business Services Fabric include : 

•	 Dynamic Assembler - Highly scalable, service personalization and semantic services 
engine that runs on the WebSphere Process Server platform 

•	 Business Services Repository - Maintains business service metadata optionally using 
WebSphere Services Registry and Repository 

•	 Business Services Subscriber Manager - Controls and automates entitlements 
•	 Business Services Governance Manager – Manage the Business Services Repository 

meta-model, provide governance for collaborative work, notification, user access 
configuration, and management, etc 

IBM® WebSphere® Business Services Fabric’s development tool is the Composition Studio 
environment. Composition Studio is used for visual modeling and management of business 
services metadata models and policies. It is an Eclipse perspective plug-in that extends 
WebSphere Integration Developer. 

In this lab, you will build and verify the integrity of a Credit Report Business Service model using 
Composition Studio. This model is used by WebSphere Business Services Fabric runtime to 
dynamically select a credit service depending on runtime characteristics of the service call using 
context, contracts, and content. 

Next, you will decorate endpoints with metadata and then create policies that use this information 
to dynamically provision appropriate services at runtime based on the service consumers needs. 

In the last section you will invoke the JK Enterprises customer account open BPEL process 
developed and deployed using WebSphere Integration Developer. This process is running on 
WebSphere Process Server. The necessary services have been deployed to its underlying 
WebSphere Application Server container. 

Your goal is to see the correct credit report service provider being selected by WebSphere 
Business Services Fabric’s Dynamic Assembler. This behavior is enabled through the Dynamic 
Assembler’s use of a consumer’s content, context and contract information combined with 
declarative business policies, endpoint capabilities and other meta-data contained in the 
Business Services Repository. 

This lab does not cover the new business spaces introduced in version 6.2. This lab is provided 
AS-IS, with no formal IBM support. 

Lab requirements 
•	 You need to complete Migration V6.1.2 lab before starting this lab 
•	 Software needed : 

o	 WebSphere Business Modeler Advanced version 6.2 
o	 WebSphere Integration Developer version 6.2 with WebSphere Process Server 

Unit Test Environment 
o	 WebSphere Tool Pack with WebSphere Business Fabric Server Unit Test 

Environment version 6.2 
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o	 WebSphere Monitor Toolkit version 6.2 
o	 WebSphere Registry and Repository version 6.1.2 or later 

•	 All PIF a and related files can be found in WDPE-v6.2-labfile.zip 
•	 These labs use username: admin and password: admin to login as administrator for any 

of the Web consoles including WebSphere Business Services Fabric and WebSphere 
Process Server. Your environment might use different credential details. 

•	 This lab requires WebSphere Process Server application port is 9081. 

What you should be able to do 
After performing this lab, participants will have: 

•	 Reviewed the WebSphere Business Services Fabric Business Service model 
•	 Created a business service model 
•	 Captured the service realizations 
•	 Verified the integrity of this business service model 
•	 Reviewed the capabilities of the credit reporting services available 
•	 Defined the assertions for each credit reporting service 
•	 Run a simple simulation without policies 
•	 Creating the Business Space variable to be used in these exercises 
•	 Created the policies for the JK Enterprises business case 
•	 Simulated JK Enterprises policies 
•	 Deployed development changes into the runtime business services repository 
•	 Ran three end-to-end test cases and evaluated the results - not simulation 
•	 Understood how WebSphere Business Services Fabric extends and enhances
 

WebSphere Process Server capabilities
 

Prior setup 

A number of tasks have been completed for you in 
advance in order to focus on core learning objectives. 
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Exercise instructions
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Part 1 Build the composite business services model 

1.1	 Create a composite business service resource hierarchy 
Using Composition Studio, you will create a composite business service resource hierarchy 
Instance. 

Composition Studio is used to: 

•	 Author and describe objects and relationships developed for use by WebSphere
 
Business Services Fabric using rich, wizard-based interfaces
 

•	 Validate the consistency and completeness of composite business services using the 
integrity checker 

•	 Simulate transactions and perform “what if” analysis based on policies 
•	 Submit changes to the governance manager for approval and publishing 

__1.	 View the OpenAccount project in WebSphere Integration Developer. 

In the migration lab, you loaded a simple JK Enterprises OpenAcct602 project and have 
associated libraries for you. This perspective contains the typical assembly life cycle 
elements developed and managed using WebSphere Integration Developer. It contains the 
BPEL, data types, assembly diagram, endpoints, and other components. 

__a.	 WebSphere Integration Developer should have opened in the default Business 
Integration perspective. If not, switch to Business Integration perspective from the 
main menu by selecting Window > Open Perspective > Business Integration. 

__2.	 View the WebSphere Business Services Fabric Project. A local WebSphere Business 
Services Fabric Project as been created for you in advance. Most of the endpoints and all of 
the interfaces have already been imported from WebSphere Integration Developer for you. 

A WebSphere Business Services Fabric project is a container in which to develop and store 
an instance of the Composite Business Service model you are building. It is called “JK 
Customer Services Process”. 
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__a. Open the Business Service perspective by selecting Window > Open Perspective > 
Other 

__b. Select “Business Service”. 

__c.	 Click OK. 

__d.	 A useful shortcut for switching perspectives in eclipse is shown in the image. Click >> 
in the upper right corner and select Business Service. 

Done during setup 

This local development project has been replicated 
from the “remote master” Business Service 
Repository. 
This replication has provided you, potentially one of 
several developers, with the extensions defined for 
the JK Enterprises business needs. 

__3. Import a project into Composition Studio 

__a. Right click the blank space to the left – under Business Service Explorer 
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__b. Click Fabric Project. 

__c. Enter JK Customer Services Process for the Project name. 

__d. Click Next. 

__e. Click Configure Project 

__f. Enter the host name (localhost) and Port: 9081 and the username and password – 
admin/admin. 

__g. Click OK then wait for the project to replicate. 
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__h. Click Next.
 

__i. Select JKEnterprisesOpenAcct from the dropdown box and click Finish and wait.
 

As a member of a development team, you have just retrieved a project from the 
Business Services Repository. 

__j. Click the project’s plus sign to expand it. 

At this time, the project is empty except for six endpoints that have been provided for 
you in advance. You are adding two endpoints yourself during the labs. These were 
provided in the interest of time. The yellow marks indicate that they are not yet 
complete. 

__4. Create your Credit Report Composite Business Service Model instance in this project. 

__a. Expand JK Customer Services Process project collection if necessary. 

__b. Right-click Application Suite and select New > Application Suite. 

Important! 

Be sure to select “Application Suite” and NOT 
“Application” 
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Application Suite 

Recall the definition for Application Suite discussed 
on page Error! Bookmark not defined.. 

__c. Enter New Business as the Name and verify that OpenAcctInstances is selected for 
the Namespace element. Click Finish. 

__d. The editor for the newly created application suite will open. Close this editor by clicking 
on its X. 

__e. Right-click Application and select New > Application. 

Important! 

Be sure to select “Application” and NOT “Application 
Suite” this time. 
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__f. Enter or verify the data in the wizard: 

Project JK Customer Services Process 

Name AcctProcessing 

Namespace OpenAcctInstances (using the drop-down) 

Application Suite New Business (using the Browse option) 

__g. Click Finish. 

__h. The editor for the newly created application will open. Close this editor by clicking on 
its X. 

__5. Create a new Business Process Service. 

This is a “process” business service because you are modeling a step in the JK Enterprises 
business process. Typically each process service is realized as a BPEL process. 

__a. Right click Business Services and select New > Business Service. 
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Business Services 

Recall the schematic and definition for Business 
Services discussed in the Composite Business 
Service Resource Hierarchy on page Error! 
Bookmark not defined.. As you can see, you are 
building out the underlying resource hierarchy of the 
Business Services Fabric Model. 

__b. Select Process Service from the option list (it should be the default). Click Next. 

__c. Enter or verify the data in the Process Service wizard: 

Project JK Customer Services Process 

Name OpenAcctBusinessSvc 

Namespace OpenAcctInstances 

Application AcctProcessing (using the Browse option) 

__d. Click Finish. 
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The Process Service editor will open. 

__e.	 In the OpenAcctBusinessSvc Process Service editor, click Details in the Channels 
section of this window. 

Alternatively you can have selected the Channels tab. 

__f. When the details window opens, click Add to the right of the Channels table 

__g. Enter or choose the information. 

Channel Name Portal 

Matching Channel Types Portal Channel (choose from available) 

__h. Click OK. 
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Channel 

A channel is a point of consumption. 
Examples include Web portal, cell phone, ATM, 
Enterprise Application, and so on. 
This is not about who is consuming the service but 
rather what that “who” is using to consume the 
service. 
Multiple channels can be defined. This is part of the 
“context” of a service call. 

__6.	 Associate a role with this channel. 

__a. Click the Role Types tab at the bottom of the editor. 

__b. Click Add Role Type. 

__c. Select Customer and click OK. 
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Role type 

A role type is the type of user that is going to 
consume the Business Service. Multiple role types 
can be selected to consume a business service. 
For a specific business, custom role types can be 
added to match company’s needs. 
Industry Content Packs, for example, provide 
commonly used industry roles. 

__d. Click the “save icon” or use CTRL-S and close this editor. 

__7.	 Create a Composite Service by importing the SCA module developed in WebSphere 
Integration Developer. 

__a.	 Right mouse click Composite Service and select New / Composite Service. 

__b.	 Accept the default detected from the process model contained in the Business 
Integration perspective and click Finish. 

The process of importing the SCA module populates both the Composite Service and 
Interface collections with information. 
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SCA import 

You are not storing the process module and contained BPEL in the 
Business Services Repository. 
This import is only extracting information about the services being 
orchestrated and not the orchestration logic. 

__c.	 Double-click the various imported components and examine the information they 
contain. 

__d.	 Close any windows you opened. Do not save changes you might have made to these 
imported components. 

__8.	 Now that you have this information, you will associate an interface with the channel you 
defined earlier. 

__a.	 Double-click the OpenAcctBusinessSvc business process created earlier to open its 
editor. (It can still be open.) 

__b. Click Details in the Channels area. 

__c. To the right of the Interfaces table, click Add.
 

__d. Select OpenAcct602 as the Module
 

__e. Verify that OpenAcctBPEL was selected as the Interface.
 

__f. Click OK.
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__g. Save and close this editor. 

You have finished defining the OpenAcctBusinessSvc Process Service. Next, you will tie this 
Business Service to the actual implementation that realizes it. 

1.2	 WebSphere Business Services Fabric enhances WebSphere 
Process Server 
In this lab section you will become more familiar with how WebSphere Business Services 
Fabric is coupled with WebSphere Process Server and its Service Component Architecture 
(SCA) programming model. 

Essentially WebSphere Business Services Fabric comes with WebSphere Process Server 
and is tightly coupled to and dependent on it. WebSphere Business Services Fabric’s 
assets, including the Dynamic Assembler SCA component, run on WebSphere Process 
Server’s underlying Java EE application server. 

The Dynamic Assembler is made available for development as a widget in WebSphere 
Integration Developer’s Business Integration perspective. During solution development, this 
Dynamic Assembler SCA widget is placed on the assembly diagram, wired to the BPEL 
solution, and then configured and instrumented. 

This WebSphere Business Services Fabric Dynamic Assembler SCA component provides 
the declarative, dynamic runtime business policy driven service provider selection 
capabilities that characterize Composite Business Services Applications. These capabilities 
enhance and extend IBM’s BPM platform. 

__9.	 Understand the invocation sequence in the general case in addition to the specific case 
used for this workshop. The invocation sequence is: 

A “client” makes a call to a BPEL-based service / process. This invocation call provides the required 
context and content information such as who is requesting a service, what channel they are using, 
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and information in the service request data payload. [In this workshop, the context was injected 
using a Java™ snippet in front of the BPEL process.] 

The BPEL process executes, orchestrating various service interactions as defined by the process 
flow. 

One or more of the BPEL’s “invoke” nodes requests WebSphere Business Services Fabric’s 
Dynamic Assembler to select and provision an appropriate service provider during runtime. The 
invoke node references the Dynamic Assembler primitive using an import / partner link. 

The Dynamic Assembler SCA component is located on the WebSphere Integration Developer 
Assembly Diagram. It receives the call as a proxy for the invoke node. 

The Dynamic Assembler consults the Business Services Registry (cached information if available) 
using the context, contract, and content (message payload) information provided by the call. It then 
builds a merged selection policy using appropriate, available business policies. It then finds 
appropriate candidates and ranks them while rejecting non-compliant endpoints. Then, it selects the 
best available endpoint to provision on behalf of the service caller using the BPEL invoke node. 

The Dynamic Assembler then invokes this selected endpoint service realization. The SCA 
programming model returns the response to the invoke node. 

__10.	 Examine the JK Enterprises Open Account BPEL process to see how WebSphere Business 
Services Fabric extends WebSphere Process Server capabilities. 

A simplified version of the BPEL process, without the data mapping nodes, is presented in 
the image below. 

This BPEL orchestrates three services in the order: Credit Check, Validate Address, and 
Process Application. 

__a.	 Switch to Business Integration perspective using the main menu by selecting Window 
> Open Perspective > Other. Select Business Integration (default). Click OK. 
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__b. Expand OpenAcct602 -> Business Logic -> Processes and double-click 
OpenAcctBPEL to open the BPEL editor. 

__c.	 The invoke nodes (circled) are making the calls to Dynamic Assembler SCA 
components. The first and last nodes provide request and response capabilities while 
the other four assign nodes map appropriate data from the service caller to and from 
each of the three services as needed. 
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__d.	 Close this editor by clicking the X. 

__11.	 Examine the Assembly Diagram that contains the Dynamic Assembler’s SCA components. 

__a. Expand the OpenAcct602 collection and double-click Assembly Diagram. 

__b.	 Enlarge the Assembly Diagram editor as needed (double-clicking on its tab will 
maximize it and double-clicking that tab again will restore the previous view). 

__c.	 Locate the component titled OpenAcctContextInjector. 

This Java snippet is used in this workshop to inject context information in to the 
OpenAcctBPEL process component wired to its right. Essentially it provides the 
subscription ID of the caller. This ID is used by the Dynamic Assembler in order to 
populate the performance database. Later you will use a Web GUI to examine 
performance information. 
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__d. Locate the three components to the right of the BPEL component you examined 
earlier. 

These are instances of WebSphere Business Services Fabric’s Dynamic Assembler 
SCA component. Generic Dynamic Assembler components were selected from the 
tool bar, dropped onto the Assembly Diagram canvas, configured, named, and wired to 
the exposed BPEL WSDL references. 

__e.	 To the right of the CreditCheckDA component, locate the two Java components titled 
CreditCheckContextExtractor and CreditCheckResponseListener. 

These are Java components that use WebSphere Business Services Fabric’s SDK to 
extend the Dynamic Assembler SCA component as needed. They are referred to 
generically as extensions. The Fabric SDK provides a rich collection of different types 
of extensions. 

The extensions (or plug-ins) used in this lab are extractContext and 
handleResponse extensions. Note that the ValidateAddressDA and the 
ProcessAppDA do not have extensions as they are providing round-robin selection of 
those service endpoints. 
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__12. Create and examine a Dynamic Assembler SCA component. 

__a.	 In the palette for the Assembly Diagram editor click the Dynamic Assembler 
component to choose it. 

__b. Then, move the mouse to a blank area on the canvas and click the canvas again to 
create a new instance of this primitive. 

__c. Click the Add Interface icon. 

__d. In the Add Interface window that opened, select VerifyCreditInterface and click OK. 
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__e.	 Double-click this new Dynamic Assembler component and click Yes when asked to 
implement it. 

__f.	 Accept the folder OpenAcct602 and click OK. 

__g.	 The following configuration window will open and reveal this component’s 
configuration. In development, you should disable caching and enable verbose 
logging. Select appropriate boxes as necessary. 

__h.	 Save and close this window. 

This is the simplest implementation of a Dynamic Assembler SCA component. 
ValidateAddressDA and ProcessAppDA are implemented exactly the same way. All 
that remains is for you to wire it to an appropriate WSDL reference based on the 
interface you selected. 

__13. Create a Dynamic Assembler extension. 

__a.	 Select the Java component from the Palette and then click the assembly diagram 
canvas to the right of your new Dynamic Assembler component. This will create an 
SCA Java component. 

__b.	 Select the Add Interface icon as you did previously. A dialog window opens for 
selecting the appropriate interface. 

__c.	 Type contextextractor in the Filter by reference window to limit the number 
interfaces provided. 

__d.	 Select ContextExtractor and click OK. 

This Java component now has an interface. 
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__e. •Click the reference wire from the right side of the Dynamic Assembler you created 
and drag it to the interface of this ContextExtractor interface. 

__f. In the Add Wire dialog box click OK to create a matching interface. 

__g.	 Double-click the Java component (the one to the right) and select Yes to implement 
the component now. 

__h.	 In the Generate Implementation widow, select (default package) and click OK. 

A Java editor window opens with a stub implementation of the ContextExtractor. A 
developer, knowing the purpose of the associated Dynamic Assembler, determines the 
needed information and implement appropriately. 

__i. Close this window. 

Out of scope 

The previous steps and further extractor / constructor 
implementation steps are outside the scope of this 
workshop. 
However, the previous steps are potentially useful for 
understanding at a finer detail how the Dynamic 
Assembler is implemented and works. 
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__14. Examine the completed CreditCheckContextExtractor used in this workshop. 

__a.	 Double-click the Java component named CreditCheckContextExtractor. This will 
open its editor and expose the underlying completed Java implementation. 

Explore the code and compare it to the stub implementation you created earlier. 

Notice that only a few additional lines of code were added. They map information from 
the message body for elements account limit and customer (employee) type into the 
message header for use by the Dynamic Assembler. 

This extension augments the simple Dynamic Assembler component by locating and 
providing needed information for runtime selection of appropriate service endpoints as 
describe previously. 

Most of the added code generates logging information for attendees of this workshop 
to see running the three test cases. 

__b.	 Close this editor by clicking its X. 

__c.	 Close the editor for OpenAcct602 – Assembly Diagram by clicking its X. 

__d.	 Click No when asked to save changes. 
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__15. Review, at a high level, the how WebSphere Business Services Fabric enhances and 
extends WebSphere Process Server capabilities. 

-

-

Module A 

Component 
A 

Import 
A 

Dynamic 
Assembly 

Component Custom 
Context 

Extractor 

Custom 
Response 
Listener 

• Dynamic Assembly is declared in the 
context of an SCA module as a custom 
component kind 

• No additional configuration is required 
from the SCA module author 

Business Services 
Repository 

• Dynamic Assembly plug-ins are integrated using SCA 

• WBS Fabric provides a integrated test environment in 
WID with classpath contributions for plug-in API and 
WBS Fabric profile for integrated testing of Dynamic 
Assembler 

WebSphere Business Services Fabric extends IBM’s SOA based BPM Platform by providing 
capabilities for flexible, declarative, business policy based semantic mediation behavior at 
run time. This enables a new class of SOA based applications called Composite Business 
Services. 

It enables dynamic business service adaptation and delivery through the use of business 
metadata and policies that eliminate or reduce hard coded (brittle) service provisioning 
(binding). 

You have completed the lab. 

1.3 Capture service realizations 
A simple Open Account process you are enabling for dynamic assembly is represented in 
the Assembly Diagram view of WebSphere Integration Developer. It contains the BPEL 
process “OpenAcctBPEL”. This process orchestrates three services - “ValidateAddress”, 
“VerifyCredit”, and “ProcessApplication”. The appropriate realization of these abstracted 
services is selected by the Dynamic Assembler at runtime based on Content, Context, and 
Contract. 
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The ValidateAddressDA service is implemented as a round robin and can be either: 

• “CICSValidateAddressEndpoint” 
• “WorldMappingsValidateAddressEndpoint” 

The ProcessApplicationDA service is implemented as a round robin and can be either: 

• “SAPProcessApplicationEndpoint” 
• “CICSProcessApplicationEndpoint” 

The VerifyCreditDA service can be realized using as any of the three services and is selected 
appropriately by WebSphere Business Services Fabric. In this workshop, your focus is on the 
selection of the correct credit reporting service based on policies, capabilities, and the 
characteristics of the consumer of the open account process. The available credit reporting 
services are: 

• “Exterian” 
• “Equinox” 
• “InternalDB” 

Equinox endpoint 

__16. Add the Equinox endpoint to your WebSphere Business Services Fabric model. 

Several endpoints have already been added and configured in advance. Because they were 
added before you imported the SCA module, their interface references were not available. 
You will add these interface references shortly. 

First, you will follow the entire procedure for adding an additional endpoint - the Equinox 
endpoint. Adding this new endpoint will quickly illustrate what “capturing service realizations” 
entails. 

__a.	 Right click the Endpoint folder in the Business Services Explorer tree view and select 
New > Endpoint. 
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__b. In the Name field enter Equinox.
 

__c. Select HTTP for the Address field using the dropdown box.
 

__d. Click Next.
 

__e. In the window that opened, paste the Equinox URL from the clipboard or type it into 
the URL field. 

URL: http://localhost:9081/AccountServices/services/equinoxVerifyCredit 

__f. Click Finish. The Endpoint editor will open. 

Notice the yellow icon warning for this new endpoint in the tree view. Associated 
descriptions are provided under the Validations tab. This endpoint does not yet support 
any interfaces. 
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__17. Associate this new endpoint to the SCA imported interface information. 

__a.	 In the Equinox endpoint editor, scroll down and locate the Associated Interfaces 
section and click Details. (or use the tab at the bottom of the endpoint editor called 
“Interfaces”) 

__b. Click Add Existing and select VerifyCreditInterface. 

__c. Click OK. 

You have associating the endpoint model in WebSphere Business Services Fabric 
with the service implementation that was acquired when you created the Composite 
Service. 

__d.	 Click the Environments tab and confirm that the automatically associated 
environment is Default. 

Environments 

In the Composition Studio Unit Test Environment 
(UTE), an Environments default setting of “Default” is 
automatically assigned. 
An enterprise typically has multiple environments 
such as development, testing, performance testing, 
and production. These are typically customized during 
setup to match your environment. 

__e. Save your work by using CTRL-S and close this editor. 
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This endpoint has no yellow warnings and is configured properly. 

Complete other endpoints 

__18.	 Associate an environment with the Web service port export for the entire process module. 
This endpoint was added when you imported the SCA module. 

__a.	 Double click OpenAcctExport_OpenAcctBPELHttpService located under the 
Endpoint collection. 

__b.	 Under Associated Environments, click Details. 

__c. Click Add Existing and select Default as the environment.
 

__d. Click OK.
 

__e. Save your work and close this editor.
 

The yellow warning marker for this endpoint has been removed. 

__19. Complete the configuration of the other endpoints. 

Importing the SCA module populated the interface collection with information. The endpoints 
already provided during lab setup now need to have their interface references associated
 
with these interfaces.
 

__a. Double-click CICSApplicationSystem under the Endpoint collection to open its editor.
 

__b. Click Details in the Associated Interfaces section.
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__c. Click Add Existing. The Interface Selection window will open. 

__d. For this CICSApplicationSystem endpoint, select ProcessApplication 

__e. Click OK. 

__f.	 Save and close this editor. 

Note that the yellow warning next to this endpoint has been removed. 

__20.	 Repeat the previous steps (a – f) to add interface references for the remaining endpoints. 

Use the information. 

Table 1: Endpoint Interfaces 

Endpoint Name Interface Name 

CICSValidateAddressEp ValidateAddressInterface 

Exterian VerifyCreditInterface 

InternalDB VerifyCreditInterface 

SAPProcessApplicationEndpoint ProcessApplication 

WorldValidateAddressEp ValidateAddressInterface 

__a.	 Close any editors you have left open. If asked to save information, verify that the 
information is correct and then close the editor. 

__b.	 Validate that there are no yellow warning icons for the endpoints. 
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__21. Now, you will create an Asynchronous Human Task Endpoint, switch to Business Integration 
Perspective. Expand the OpenAcct602 Module in the Project Tree and expand the 
Assembly Diagram, click OpenAcctExport to open the Assembly Diagram. 

__22. From the Palette Menu, select Human Task and Drop onto the Assembly Diagram. 

__23. Rename the component HumanApproval. 
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__24. Select an Export from the Palette and drop it onto the Assembly Diagram. 

__25. Rename the SCA Component as HA-Export. 

__26. Click the Human Approval interface, then select the “I” within the Purple circle to add an 
interface. 

__27. A floating Window should appear and select the Process Application interface and click OK. 

__28. Repeat the previous two steps for the HA-Export component and wire the two components 
together. 
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__29. Right click HA-Export and select Generate Binding and choose the SCA Binding. 

__30. Double click the Human Approval Task, click Yes to generate the implementation. 

__31. Accept the default and click OK. 

__32. If not already provided, Enter HumanApproval as the the name for the Human Task and click 
OK. 

__33. This window should appear. Close it once done looking at it. 
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__34. Return to the Assembly Diagram, right click the HumanApproval Task and select Show in 
Properties 

__35. Select the Details Tab within the Properties Tab make sure the information below is 
displayed. 

2009 May, 21 IBM WebSphere Business Services Fabric 6.2 – Lab exercise Page 34 of 123 

LegacyBusinessApplication-Lab_2-AssembleAndDeployCBA.doc 



        

                

 

 

          

 

             
   

 

         

© Copyright IBM Corporation 2009 All rights reserved 

__36. Add a Java Component next to the ProcessAppDA 

__37. Rename the component ProcessContextExtractor, click the component and select the add 
interface purple circle. 

__38. Select the ContextExtractor Interface and click OK. 
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__39. Wire the ProcessAppDA component to the ProcessContextExtractor Component 

__40.	 Click OK to generate the matching reference. 

__41.	 Double click the ProcessContextExtractor Component and implement the component by 
clicking Yes. 

__42.	 Click the New Package button and type com.ibm.websphere.fabric.openacct.processHA 
and click OK then click OK again. 
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__43. The following window should appear. Replace all the text with the text contained in the 
ProcessContextExtractorImpl_Java.txt. 

__44. Save and close the window.
 

__45. Right click the OpenAcctBPEL and select Show in Properties
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__46.	 Select the Details Tab within the Properties Tab and expand the References Tree, select 
the References and then select the Qualifier Tab. Click the Add button and add the 
Asynchronous invocation. Click OK. 

__47. Make sure you choose the Commit Value for the Asynchronous invocation Properties. 
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__48. Verify these properties have been assigned to the three references: creditCheckPartner, 
processAppPartner, and validate AddressPartner. 

__49. Select the OpenAcctBPEL and the details tab, change the preferred interaction style to 
Asynchronous. 

__50. Save all changes by selecting File > Save All 
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__51. Return to the Assembly Diagram and Right-click the OpenAcctBPEL, select Open. 

__52. This will open the BPEL window. Select show in properties, then the details tab and select 
Process is long running. 
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__53. Save changes by clicking Ctrl +Shift + S 

__54. Return to the Assembly Diagram and right click OpenAcctBPEL. Select Show in Properties 

__55. Select the OpenAcctBPEL and the Qualifiers tab 

__56. Set Join Transaction value to False 

__57. Save changes by clicking Ctrl +Shift + S 

__58. Right click the CreditCheckDA and select Show in Properties. Select the Details tab and 
expand the Interfaces tree and select the verifyCredit Interface. Click the Event Monitor tab 
and select “All” and leave the default values of Full and Existing. This will enable Fabric 
Events to be monitored later in the lab. 

__59. Now, switch to Global Event Settings Tab, select the WebSphere Business Monitor 6.2 
format. A window should appear and click OK. 
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__60. Save Project by clicking the Floppy Disk in the upper left corner. Wait for the Workspace to 
finish rebuilding. 

__61. Select Project -> Clean from the menu bar and clean all projects. 

__62. Switch to Business Service Perspective, Select New Composite Service. 

__63. Accept the Defaults and click Finish. 
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__64. A window with import warnings and click OK. 

__65. Your Workspace should appear similar to the one displayed below: 

__66. Open the HA-Export Endpoint and select the Environment sub-tab, then click Add Existing 
and Choose Default. Click OK. 
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__67. If you have two OpenAcctExport_OpenAcctBPELHttpPort endpoints, delete the extra 
endpoint. The extra endpoint does not have an environment defined. 
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__68. Save the project by Ctrl+Shift+S 

You have completed this lab. In the next part you will define business policies and then use 
them to simulate dynamic selection of an available credit reporting services based on 
declarative business policies. 
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Part 2 Define and simulate business service policies 

2.1 Review credit reporting services 
WebSphere Business Services Fabric uses customer context, message content, and generates 
a merged business policy contract to provision the correct service. For reference a review of the 
available credit reporting services and their capabilities follows: 

•	 InternalDB – An internal Web service that uses a database containing stored credit
 
reports for customers with “EXISTING” accounts. The cost of retrieving a credit report
 
from this service is $0.00 per transaction. It only supports credit requests that are
 
considered to be “SMALL”. Also, this service is not available on Sundays due to
 
maintenance.
 

•	 Equinox – A vendor provider of credit assessment reports. They charge $1.50 per 
transaction. This service can support both “NEW” and “EXISTING” customers. It only 
supports credit requests that JK Enterprises considers “SMALL”. The accuracy of their 
data is considered to be of medium grade quality because they update their records on a 
quarterly basis. They support credit requests 24 x 7 x 365 – always available. This is the 
endpoint you built out in the previous lab section and whose policies you will focus on in 
this lab section. 

•	 Exterian – A vendor provider of credit assessment reports. They charge $5.00 per 
transaction. This service can support both “NEW” and “EXISTING” customers. JK 
Enterprises only uses this service for credit requests that are considered “LARGE”. The 
accuracy of this credit reporting agency’s data is very high. They update their records on 
a monthly basis - and charge a premium for this. They support credit requests 24 x 7 x 
365 – always available. 

•	 HA-Export – this endpoint was added to demonstrate the asynchronous capability with a 
Human Task a feature now available as of Fabric version 6.1.2. It is triggered when an 
account credit request is greater than $20,000. 

2.2 Declare endpoint assertions 
By executing the steps in this section, you are informing WebSphere Business Services Fabric of 
the capabilities associated with the credit service providers available to JK Enterprises. 

These capabilities are called “assertions”. They are stored in WebSphere Business Services 
Fabric’s meta-model inside the Business Services Repository. At run time the Dynamic 
Assembler uses these endpoint assertions, the service consumer’s information, and declarative 
business policies to select the “best” service provider endpoint that meets the requirements. 

There are five dimensions along which assertions can be applied: 

♦	 Performance 
♦	 Reliability 
♦	 Interoperability 
♦	 Security 
♦	 Manageability 

You will only apply a few assertions in this lab. 
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Equinox assertions 

__69. Refocus the endpoint editor for the Equinox endpoint. 

__a. Double-click Equinox in the Endpoint folder to open its editor. 

__70. Add the account size assertion to the Equinox credit service. 

Assertions are used to describe capabilities or 
requirements. 

Endpoint assertions describe the capabilities of 
endpoints. 
Policy assertions describe requirements for different 
contexts used by the Dynamic Assembly for endpoint 
selection. 

__a. Click the Assertions tab for this editor. 

__b.	 Click Add located in the upper right corner of the Endpoint Capabilities table. 

Recall that JK Enterprises only wants to use this credit reporting service for small loan 
requests. 

__c.	 Expand the Interoperability folder and, under it, expand the Content Based 
Assertion folder. 

__d.	 Select AccountSizeAssertion and click OK. 
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__e. In the window that opens, select SMALL from the drop down box then click OK. 

You have created an instance of this assertion type and associated it with this 
endpoint. There is now a row for this assertion in the table. 

__71. Add the CustomerType assertion to the Equinox credit service. 

Recall that JK Enterprises wants both new and existing customers to be supported by this 
service. 

__a. With focus still on the Assertions tab, click Add.
 

__b. Expand the Interoperability and then the Content Based Assertion folders.
 

__c. Select the CustomerTypeAssertion and click OK.
 

__d. In the window that opens, select EXISTING as customer type and click OK.
 

A second row will have been added to the assertion table indicating that this endpoint 
supports existing customers. 

__e. Add a CustomerTypeAssertion of value NEW using the same procedure. 

A third row is now visible in the assertion table. 

__f. Verify that you have three rows in the Endpoint Capabilities assertion table as shown 
below. 
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__72. Add the cost that Equinox charges JK Enterprises for their credit report service.
 

Recall that they charge $1.50 per credit report transaction.
 

__a. Click the Overview tab at the bottom of the editor.
 

__b. Locate the Resource Information area of the editor. (upper right corner) 

__c. Enter the information for the Cost and Cost Modifier fields. 

Cost: 1.5 

Cost Modifier: Transaction (using dropdown box) 

__d. Save your work. 

__e. Close the Equinox editor. 

Other endpoint assertions 

__73. Validate other endpoint assertions. 

Assertions have already been added for InternalDB and Exterian credit services. 

__a. Open each of these endpoints and examine their values to verify correctness. 

Table 2: Endpoint Assertions 

Assertions InternalDB Exterian 

Customer Type EXISTING NEW & EXISTING 

Account Size SMALL LARGE 

Cost 0.0 5.00 

__b. Close their editors. 
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You have defined or validated the endpoint assertions (capabilities) for the three credit 
reporting services. 

__74. Double click the HA-Export Endpoint editor and select the assertions tab, click Add. 

__75. Select the Units of Work Assertion and click OK 

__76. Enter a value of 5 and click OK. 
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__77. Add 2 for Cost and Select Transaction for Cost Modifier 

__78. Save the HA-Export Endpoint. 

__79. Save and Close all the Endpoint Editor pages by pressing Ctrl+Shift+ W. 

2.3 Simulate a simple case 
You will run a simulation to observe endpoint selection behavior before defining JK 
Enterprises business policies for endpoint selection. 

This will show one aspect of how WebSphere Business Services Fabric selects endpoints. 

__80. Open Policy Simulator to run a simple simulation. 

__a. Right click the Simulation collection and select New > Simulation. 
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__b. In the Name field enter Simple Cost Simulation, accept the other default values 

__c. Add a useful description, and click Finish. 

The Business Policy Simulation configuration window will appear. 

__d. In the Required Context area, click Browse and select VerifyCreditInterface, and 
click OK. 

__e. Click Run located in the bottom right corner. 

__81.	 Analyze the results of this simulation. 

Recall that you have not yet specified any policies. 

__a. The Results tab will become active, indicating the simulation steps taken. 

__b. Below the Results tab, the Simulation Operation tab contains the results of the 
simulation. The InternalDB credit service was selected.
 

The Console tab periodically becomes active and can move in front of the Simulations
 
Operation tab.
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__c. Click Details associated with the Find candidates operations area of the results tab. 

In the Simulation Operation tab under Candidate Endpoints, Three services were 
evaluated and ranked. 

The Dynamic Assembler chose the InternalDB endpoint. This is because the default 
criterion used to select a service is cost. InternalDB is the cheapest endpoint available. 

If no business policies are available and available endpoints are essentially equal, 
lowest cost wins. (You will create some business policies shortly.) 

Optional further investigation 

As an exercise, vary the transaction costs of the 
endpoints (overview tab) and re-run this simulation. 
Return costs to their original values and save them 
before proceeding. 

__d. Save and close the Simple Cost Simulation window. 

Notice that this test case has been saved to the Simulation folder. This collection 
provides a collection of reusable simulation. 

2.4 Create Business Space Variable 

__82. In the Business Service Perspective, select New Business Variable 
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__83. Enter text in each of the fields below and select Next. 

__84. In the next window, finish defining the Business Variable and click Finish 
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__85. The Business Variable editor window should now appear. Save the project. 

__86. In the Repository Changes Tab, click the submit changeset button. 
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__87. Select Next, Add All, then Finish. After the changeset has successfully been completed. 
Click OK. 

__88. Click the Update Project button from the repository Changes Tab. 

__89. Click Finish and then OK. 

__90. Open a New Web Browser to https://localhost:9444/BusinessSpace/banner.jsp The following 
webpage should appear. Login as the administrator using admin/admin. 
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__91. In the browser select the New Business Space Icon, select Business Process Agility 
template, provide a name and click the OK button. 

__92. In the Business Space Browser select New Page icon. 
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__93. A floating window should appear, provide a name and click OK. 

__94. Click the Add a widget link 

__95. Add a Business Variables Widget and click OK. 

__96. A successful implementation of the Business Space Variable is seen below: 
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2.5 Create the JK Enterprises policies 
JK Enterprises has established business policies for when the different credit services are to 
be used. These easily modifiable “declarative” policies represent how JK Enterprises wants 
to do business at this time. The Dynamic Assembly component consults these business 
policies at run time before selecting a service that meets the service caller’s needs. 

In this section you will create and capture this policy information in WebSphere Business 
Services Fabric. 

__97. Switch back to WebSphere Integration Developer > Business Services perspective. 

__98. Review the JK Enterprises Endpoint Assertions and Use Cases. 

Recall that: 

Customer types requesting credit are EXISTING or NEW. 
Account size (Credit request amounts) are SMALL or LARGE: 

Below is a tabular representation of JK Enterprises service provider endpoint capabilities 
(assertions) and use cases for service consumers. 

The top row depicts the service providers available while the left column represents service 
consumer use cases. 

The check marks represent which service provider endpoint is to be selected based on the 
context, content and contract of the service consumer’s request. 
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S E R V I C E 

PROVIDER 

► 
SERVICE 

CONSUMER ▼ 

InternalDB 
Cost: $0.00 

Customer Type Supported: 
EXISTING 

Account Size Supported: 
SMALL 

Availability: Monday through 
Friday 

Equinox 
Cost: $1.50 

Customer Type Supported: 
NEW and EXISTING 

Account Size Supported: 
SMALL 

Availability: 24x7 

Exterian 
Cost: $5.00 

Customer Type Supported: 
NEW and EXISTING 

Account Size Supported: 
LARGE 

Availability: 24x7 

Customer = NEW 

Account Size = SMALL ($5000) 

Day of the Week = Monday 

Customer = NEW 

Account Size = LARGE ($15000) 

Day of the Week = Tuesday 

Customer = EXISTING 

Account Size = SMALL ($5000) 

Day of the Week = Tuesday 

Customer = EXISTING 

Account Size = LARGE ($25000) 

Day of the Week = Tuesday 

Customer = EXISTING 

Account Size = SMALL ($5000) 

Day of the Week = Sunday 

Small account size policy 

__99. Create the first of two policies for account size. 

The JK Enterprises policy that you are going to create specifies account size based on 
customer’s AccountLimit information contained in the service request. (This information is 
provided in the request message data set as “content”). 

This is the policy you will establish. 

If AccountLimit < $10,000 (or as redefined by the Business Space Variable) then AccountSize = 
SMALL 
If AccountLimit > or = $10,000 (or as redefined by the Business Space Variable) then 
AccountSize = LARGE 

Policy formula 

A policy has the formula: 
If (condition) then (contract) 
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__a. Right click the Policy folder and select New > Policy. 

__b. In the Create a Policy wizard, enter SmallAcctSize for Name.
 

__c. Click Browse for the Target field
 

__d. Click Interface under the Technical object collection on the left.
 

__e. Under Matching Objects, select VerifyCreditInterface and click OK.
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__f. When focus returns to the “Create a Policy” window click Finish. 

Policy availability 

Leaving the Start Date and End Date empty means 
that this policy is available and in effect as soon as it 
is applied using governance to the production runtime 
Business Services Repository and will not expire. 

__100. Click Policy Expression tab 

__101. Right click in the Expression box and select the information: 
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__102. Add the expression : 

Content Type AccountLimit (select from drop down list) 

Comparison is less than (select from drop down list) 

__a. Click Add Content. 
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__b. In the box for AccountLimit click the icon to the left of the text field. 

. 

__c. Choose the Business Variable that was created earlier and click OK. 

This represents the condition or left side of the policy equation. 

(condition) then (contract) 

If AccountLimit < set Business Variable then AccountSize = SMALL 

__d. Be sure that you selected AccountLimit and not AccountSize. Click OK. 

Account limit is the information about customer account that is used to help determine 
what type of credit report is appropriate for them. 

__e. Click OK three times. 

__f. Click Finish to close the Policy Content window. 

__g. In Assertion table click Add. 
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__h. Expand the Interoperability Assertion folder and under it, expand the Content Based 
Assertion folder. 

__i. Select AccountSizeAssertion and click OK. 

A window for specifying the AccountSizeAssertion contract has opened. 
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__j. Select SMALL and click OK. 

SMALL and LARGE are extensions available for this 
(and possibly other) business service models. 
Recall the discussion earlier when assigning 
assertions (capabilities) to your endpoints. You are 
now assigning assertions to this policy. (Policy 
Assertions) 

__k. Verify that a row has been added to the Policy Assertions table. 

__l.	 Save the policy you have developed then close this editor. 

A policy has been added to the collection under Policy in the tree view. 

Large account size policy 

__103. Create a policy for customers requesting LARGE loans. 

The policy you are developing next is as follows: 

If AccountLimit > or = to $10,000 then AccountSize = LARGE 

__a. Right click the Policy folder and select New > Policy. 

__b. In the Create a Policy window, enter LargeAcctSize as the policy name and click 
Browse. 

__c. Under Technical object, click Interface. 
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__d. Select VerifyCreditInterface and click OK. 

__e. Click Finish in the Create a Policy window. 

__f. Click Policy Expression tab 

: 
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__g. Right click in the Expression box and select: 

__h. Specify the information using the steps described earlier. 

Content Type AccountLimit (select from drop down list) 

Comparison is greater than or equal (select from drop down list) 

Add Content Select the created Business variable 

__i. Be sure that you selected AccountLimit and not AccountSize. Click OK. 

__j. Click OK again (three times). 

__k. Click Finish to close the Policy Content window. 

This represents the condition or left side of the policy equation. 

(condition) then (contract) 

If AccountLimit > or = $10,000 then AccountSize = LARGE 

__l. In the Assertion table below click Add. 

__m. In the Select Assertion Type window, expand Interoperability Assertion and then 
expand the Content Base Assertion collection. 

__n. Select AccountSizeAssertion and click OK. 
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__o. The AccountSizeAssertion window will open. Select LARGE for AccountSize and then 
click OK. 

__p. The final result will look like: 

__q. Save the policy you have developed and close its editor.
 

There are now two policies, LargeAcctSize and SmallAcctSize, in the Policy folder.
 

Customer type policy 

__104. The policy that you will create next will specify that a customer type is required by the 
Dynamic Assembler - NEW or EXISTING. 

The service caller provides a set of data when making a service call. One of the data fields 
contains customer type information. Only the values NEW or EXISTING are allowed. There 
is no need to define a specific policy assertion contract. It is provided by the caller’s 
message data. 

The endpoints are decorated with information about the types of customers that they 
support. InternalDB only supports EXISTING customers. The other credit services support 
both NEW and EXISTING customers. 

__a.	 In the tree view to the left, right-click the Policy folder and select New > Policy. 

__b.	 In the Create a Policy window, enter CustomerType as the policy name and click 
Browse. 
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__c. Expand the Technical collection and click Interface. Then, select 
VerifyCreditInterface and click OK. 

__d. When focus returns to the “Create a Policy” click Finish. 

__e. Click Policy Expression tab 

__f. Right click in the Expression box and add OR condition 

Prefix Notation 

The expression box in the policy editor adds policies 
in prefix notation. There fore you first define the 
operator – OR and then add the left and right side of 
the operator – Customer Type = NEW OR Customer 
Type = EXISTING 
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__g. Next you will assertions by right clicking the OR operator in the Expression box and 
selecting Assertion. 

__h. Specify the assertion information. 

Content Type CustomerType (select from drop down list) 

Comparison is equal to (select from drop down list) 

Add Content NEW (click Add Content and select ) 

__i. Click OK and click OK again. 

__j. Verify that you have generated: 

__k. Similarly add the second assertion condition to the OR operator. Specify the 
information stated below 
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Content Type CustomerType (select from drop down list) 

Comparison is equal to (select from drop down list) 

Add Content EXISTING (select from drop down list) 

__l. Click OK and click OK again.
 

__m. Verify that you have generated the information below :
 

. 

__n. In the Assertion table below click Add. 

__o. Expand Interoperability Assertion and Content Based Assertion folders. 
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__p. Select CustomerTypeAssertion and then click OK. 

__q. In the CustomerTypeAssertion window that opened, check the selection box for Fill 
from Context and verify that Required is checked as well. Click OK. 

__r. The final result will look like : 

__s. Save and close this policy editor to add this third policy to Policy collection. 

__t. Save all open windows with Ctrl+Shift+S 

__u. Close all open windows Ctrl+Shift+W 
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Policy to trigger the Human Task (Asynchronous Capability) 

__105. The policy that you will create next will trigger the Human Task that you added to the 
assembly diagram in a previous lab. Basically, any loan request that is greater than $20,000 
will require human approval before selecting the appropriate endpoint. 

__a.	 In the tree view to the left, right-click the Policy folder and select New > Policy. 

__b.	 In the Create a Policy window, enter AccountLimit as the policy name and click 
Browse. 

__c.	 A window should appear and select the ProcessAppDA and click OK. 

__d. When your focus is back on Create Policy window click Finish 

__e. Click Policy Expression tab 

: 
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__f. Right click in the Expression box, select this: 

__g. Specify this information using the steps described earlier. 

Content Type AccountLimit (select from drop down list) 

Comparison is greater than (select from drop down list) 

Add Content 20000 

__h. Be sure that you selected AccountLimit and not AccountSize. Click OK.
 

__i. Click OK again (three times).
 

__j. In Assertion table below click Add
 

__k. Select the Units of Work assertion and click OK.
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__l. In the window, leave the Required checked and type 5 in the text field and click OK. 

__m. Save and close the editor. 

Monitoring policy 

__106. The policy that you will create next is needed for monitoring Fabric events 

__a. In the tree view to the left, right-click the Policy folder and select New > Policy. 

__b. In the Create a Policy window, enter FabricEventsPolicy as the policy name and click 
Browse.
 

__c. Select the CreditCheckDA and click OK.
 

__d. Then click Finish. 

__e. Click Policy Expression tab 
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__f. In the Assertion table click Add 

__g. Expand Manageability Assertion -> CBE Enablement Assertion. Select the 
Context Extraction Assertion and click OK. 

__h. Remove the required checkmark, click the enable Context Extraction Event, and 
click OK. 

__i. Click the Add button and repeat the previous three steps for the remaining four 
assertions: 
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1 Dynamic Selection Event 

2 Endpoint Not Available Event Enablement 

3 No Endpoint for Policy Event Enablement 

4 Technical Error Event Enablement 

__j. The final assertion table should be similar to : 

__k. Save and close the policy editor window. 

2.6 Simulate JK Enterprises policy usage 
The simulation capabilities of the Composition Studio perspective of WebSphere Integration 
Developer provide a facility for testing endpoint selection scenarios. Detailed results are 
available for each step in Dynamic Assembler’s process of determining which service is 
appropriate. This simulation allows developers to test, troubleshoot, and modify or author 
policies to generate the necessary results for the business. 

Endpoint Selection consists of following three major steps or operations: 

Build Selection Policy: Find all policies applicable for the current context and composes them 
into a merged selection policy 
Find Candidates: Filter endpoint candidates that do no match the requirements for the 
selection (rejected candidates) and rank candidates that meet the requirements 
Select Endpoint: Pick the best endpoint from the candidates base their ranking 

Previously, you ran a simple simulation without policies. That simulation always resulted in 
the selection of the least expensive endpoint. Because there were no business policies, 
lowest cost was provisioned. 

In this section you will simulate and test the behavior of the Dynamic Assembler as it selects 
the appropriate endpoint service using policies you previously defined. 
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Context Specification 

It is a best practice to create a custom Context Specification for implemented Dynamic 
Assembly components. This context specification component formalizes the contract 
between the service consumer and the Dynamic Assembler. 

There are two default Context Specifications provided. They are: 

♦	 Fabric Hub Context: Supports earlier versions with the deprecated hub deployment 
model. The only required dimension is the service interface. 

♦	 SCA Default Context: Default context specification used with SCA-style Dynamic 
Assembly invocations. The required dimensions are Composite Service, Dynamic 
Assembler Component, and Interface – all of which are provided automatically when 
using the SCA component for Dynamic Assembly. 

When you built and ran your Simple Cost Simulation, only the interface was provided for 
you. You did not select and specify values in the Optional Context portion of the Simulation 
Input parameter view. 

Besides strongly formalizing the contract between service consumer and the Dynamic 
Assembler, another benefit of utilizing context specifications is to provide fine-grained control 
during simulation and runtime. 

Creating a simulation for that Dynamic Assembler component will automatically add your 
required context dimensions to the simulation configuration. One only needs to specify the 
values before running simulations. 

__107. Create a Context Specification to be used for the simulations you will run shortly. 

__a. Right click the Context Specification folder and select New > Context Specification. 

__b. Enter VerifyCreditContextSpec for the name and click Finish.
 

__c. In the configuration window that opens, click its Dimensions tab at the bottom.
 

__d. Click Add associated with the Content-based Dimensions table.
 

__e. Select AccoutLimitAssertion and click OK.
 

__f. Click Add again, select CustomerTypeAssertion, and click OK.
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__g. Verify that your Content-based Dimensions are now configuration as shown in the 
image. 

__h. Save and close this editor. 

The Context Specification folder now contains your custom specification. 

__108. Apply this context specification to the credit report Dynamic Assembler component. 

__a. Expand the Composite Service folder and then expand the OpenAcct602 process 
module’s collection of Dynamic Assembler components. 

__b. Double click CreditCheckDA to open its configuration editor. 

__c.	 Select context specification associated with this Dynamic Assembler Component by 
clicking on Browse 

__d.	 Select VerifyCreditContextSpec and click OK. 

__e.	 Verify that you have the configuration shown below : 

__f. Save and close this editor. 

Simulate InternalDB 

__109.	 Simulate a JK Enterprises use case that should select InternalDB. 

__a. Right click the Simulation collection and select New > Simulation. 
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__b. In the Name field enter Test Verify Credit.
 

__c. Select CreditCheckDA for the Dynamic Assembly Component field.
 

__d. Accept the other default values and click Finish.
 

The Simulation configuration window will open. 

__e.	 Select AccountLimitType and CustomerType by clicking Add Content Based 
Dimensions 

__f. Click Edit for AccountLimit, enter 5000, and then click OK. 

__g. Click Edit for CustomerType; select EXISTING from the dropdown box, and click OK. 

The results should look like : 

__h. Click Run located in the bottom right corner. 
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__110.	 Analyze the simulation results 

__a.	 View the results using the Simulation Operation tab located below the simulation 
window. 

InternalDB was selected as expected. 

The Dynamic Assembler selected this endpoint because the account size for the credit 
request was SMALL (<10000) and customer was EXISTING. 

This behavior adheres to how JK Enterprises’ business policies “declare” how it wants 
to use various credit reporting services today. 

Endpoint tier ranking 

__111.	 Review the steps that the Dynamic Assembler took as it determined that InternalDB was the 
correct credit service for this service consumer request simulation. 

The green checks represent these steps. 

__a. In the Results tab for this simulation, click the Details hyperlinks for: 

Build selection policy 

Find candidates 

Select endpoints 

__b.	 Click the Details link for Find candidates. 

Notice that two endpoints meet the specified requirements. They are shown under the 
Simulation Operation tab under the Candidate Endpoints tab. 
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When endpoint candidates are selected during the “Find candidates” step, they are 
placed into tiers. Each of the usingble candidates identified must meet all of the 
requirements specified in the merged selection policy. They also have to match any 
required endpoint specified assertions. 

These candidates are then assigned a tier number or ranking based the normalized 
(per transaction) cost of the endpoint and the number of matched optional assertions. 

The tier number is an integer number. The lowest number is the best ranking. Cost 
takes precedence only when all required and optional policy and endpoint assertions 
are equally met. Essentially, the candidate endpoints are considered equal. 

A lower cost endpoint with fewer matched optional assertions is ranked more highly 
(less favorably) than a higher cost endpoint that matches more optional assertions. 

All usingble candidates that have the same cost AND the same number of optional 
assertions matched are placed into the same tier. If more than one suitable endpoint is 
ranked in the best tier (lowest number), the Dynamic Assembler will alternately pick 
among these endpoints in a round-robin fashion. This distributes the load across 
essentially equivalent endpoints. 

No round-robin during simulation 

A round-robin between suitable endpoints is only 
applied to the server version of the Dynamic 
Assembler. 
When using the Dynamic Assembler Simulator, a 
single endpoint is repeatedly selected from among 
equivalently ranked endpoints based on its creation 
timestamp. 

Simulate Exterian 

__112.	 Simulate a JK Enterprises use case that should select Exterian as the result. 

You will use the values: 

Customer NEW 

Account Size 15000 (LARGE) 

__a.	 With the Test Verify Credit simulation window still open, click the Simulation Input 
tab. 

__b.	 Click Edit for AccountLimit, enter 15000, and then click OK. 

__c.	 Click Edit for CustomerType, select NEW from the dropdown box, and click OK. 

__d.	 Click Run. 
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__113. Analyze the simulation results
 

As expected, the selected endpoint is now Exterian.
 

__a. In the Results tab, click the Details hyperlink for Find candidates.
 

__b. Click the Rejected Candidates tab under the Simulation Operation tab.
 

__c. Two credit services, InternalDB and Equinox were rejected because they did not meet
 
the selection policy’s requirements. 

Simulate Equinox 

__114.	 Simulate a JK Enterprises use case that should select Equinox. 

Use the values: 

Customer NEW 

Account Size 5000 (SMALL) 

__a. Click the Simulation Input tab.
 

__b. Click Edit for AccountLimit, enter 5000, and then click OK.
 

__c. Verify that CustomerType is NEW.
 

__d. Click Run.
 

__115.	 Analyze the simulation results 

As expected, the selected endpoint is now Equinox. 

__a. Save and Close the simulation window. 
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You created a custom context specification and policies. Then, you simulated the behavior 
of the business services model you defined. . 
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Part 3 Deploy and run the composite business service 

3.1 Local development change set submission 

__116. Submit your local change set to update the Business Services Repository. 

A change set is a collection of related meta-data changes that an individual developer has made 
in their localized project. 

Local and remote repositories 

WebSphere Integration Developer with its Business 
Integration and Composition Studio perspectives 
contains a Unit Test Environment. It includes a fully 
functional WebSphere Process Server for stand-alone 
development and testing. 
During development and simulation of Composite 
Business Services, a local eclipse repository is 
consulted. 
When running an actual process rather than 
simulating it, WebSphere Business Services Fabric’s 
Dynamic Assembler consults an actual Business 
Services Repository. 
Before running actual process executions, you first 
need to update that runtime repository. 

__a. Locate the Repository Changes view in the bottom left of this eclipse environment. 

__b. Right click Active Changes and click Submit Changelist. 

__c. Click Next in the Changes Wizard. 
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__d.	 Click Add All >> to move all of your development changes to the Selected Changes 
window and then click Finish. 

__e.	 In the Confirm Submit to Business Services Repository window, click Yes. 

__f.	 In the Change Submission Status window click OK. 

Notice that there is now an entry in the “Pending Changesets” folder. 

__g.	 At the root of the tree, right-click JK Customer Services Process and select Update 
Project. 

__h.	 In the Update Project dialog box, select Finish. 

__i.	 In the Project Update Results dialog box, select OK. 

This process has moved your changes to the runtime Business Services Repository. 
WebSphere Process Server will now have access to this metadata during runtime. 
Additionally, you also resynchronized your local Composition Studio environment. 

In this Unit Test Environment, governance approval of change sets is automatic. 
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3.2	 Create the Monitor model 
You are ready to create the Monitor model and then run the end-to-end JK Enterprises Open 
Account BPEL process. This process orchestrates three services (ValidateAddress, VerifyCredit, 
and ProcessApplication) in order to open a new loan account. 

Your goal is to validate that the correct credit report service provider is being selected and 
provisioned by the Dynamic Assembler for the four use cases. 

__117.	 Switch to the Business Integration perspective and click OK. 

__118.	 Right click the OpenAcct602 module, select Monitor Tools and Generate Monitor Model to create 
a new Monitor Project. 

__119.	 In the Generate Monitor Model window enter: 

__a. Target monitor project : OpenAcct602MonitorProject 

__b. Target monitor model name : OpenAcct602MonitorModel 
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__c. Click Next. 

__120. Click Yes to create the Project.
 

__121. In the New Business Monitoring Project click Next.
 

__122. Select the JKEnterpriseLibrary, OpenAcct602. Click Finish 
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__123.	 A window should appear. Expand the CreditCheckDA and select the 
VerifyCreditInterface.verifyCredit. 

__a. Select all the Emitted Events and then click Next. 

__124. Click Finish and then click Yes to switch to the Business Monitoring Perspective. If you are 
asked to open Getting Started guide click No. 
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__125. Open in Windows Explorer, <ToolPack_Home>\library\monitor\schema folder and drag the 
files into the OpenAcct602MonitorProject > Events Definitions. 

__126. In the Monitor Details Model right click OpenAcct602Module and select New > Events Group 
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__127. Give the Events Group name FabricEventsGroup and click OK. 

__128. FabricEventsGroup is created in the tree view. Right click it and select New > Inbound Event 

__129. Enter name DynamicSelectionEvent and click OK. 
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__130. Scroll Down and click Add under the Event Type Details 

__131.	 Enter Name: DynamicSelectionEvent 

__a. Click Select Type.. 

__b. Expand the tree and select the Dynamic Selection Type 

__c. Click Next. 
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__132. Type dse as a prefix and click Finish 
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__133.	 Click Finish in the Create New Event Part type window. 

__134.	 In the Filter Condition, type CTRL-<space> to open the window, expand the tree, and select 
component string from under the Dynamic Selection Event. 

__135.	 Complete the string by adding ="sca://OpenAcct602/CreditCheckDA" to the end. The final 
string should be : 

DynamicSelectionEvent/DynamicSelectionEvent/dse:ComponentInfo/common:component="sca:// 
OpenAcct602/CreditCheckDA" 

__136.	 Scroll down to the Correlation Expression, use ctrl-<space> to select the wbiSessionId from 
the DynamicSelectionEvent. The final string is 

WBISESSION_ID=DynamicSelectionEvent/DynamicSelectionEvent/dse:wbiSessionId 
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__137. Change the values for drop downs as described. 

__138. Save changes by clicking Ctrl+Shift+s 

__139. Create a new trigger by selecting the module 

__140. Enter Trigger name DynamicSelectionTrigger 
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__141. Enter Trigger Source by clicking Add 

__142. Select DynamicSelectionEvent 

__143. Click OK and verify the trigger source has been added. 

__144. In the Trigger Condition, type CTRL-<space> to open the window, expand the tree, and select 
component: string from under the DynamicSelectionEvent. 
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__145. Make sure your final TriggerCondition is the same as shown below. The final string is : 

DynamicSelectionEvent/DynamicSelectionEvent/dse:ComponentInfo/common:component="sca://OpenA 
cct602/CreditCheckDA" 

__146. Create another Trigger and name it EntryTrigger 

__147. Add Trigger source VerifyCreditEntry and click OK. 
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__148.	 Add a Trigger condition : 
VerifyCreditInterface.verifyCreditENTRY/ComponentData/sca:TARGET_COMPONENT = 
"CreditCheckDA" 

__149. The final EntryTrigger Source and Condition should be exactly as follows: 
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__150. Create a new Trigger and name it ExitTrigger
 

__151. Add Trigger Source VerifyCreditInterface.verify.CreditExit and press OK.
 

__152. Fill out the ExitTrigger Source and Condition such that it looks like: 

VerifyCreditInterface.verifyCreditEXIT/ComponentData/sca:TARGET_COMPONENT = 
"CreditCheckDA" 
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__153. Save All changes
 

__154. Create a New Metric by right clicking on the module, select New -> Metric.
 

__155. Name the metric CreditRequested and click OK 

__156. Select Type Decimal 

__157. Select EntryTrigger under Trigger 

__158. Select Expressions: 
VerifyCreditInterface.verifyCreditENTRY/VerifyCreditRequest/bo:application/requestedCreditLimit 
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__159. The final screen should look like : 

__160. Create a new metric and this time name it EndPointSelected and click OK. Fill out the fields 
such that they match the ones shown. 
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Trigger: DynamicSelectionTrigger 

Expression: DynamicSelectionEvent/DynamicSelectionEvent/dse:SelectedEndpoint/dse:address 

__161. Create a new metric and this time name it TargetComponent, click OK. Fill out the fields such 
that they match the ones shown. 
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Trigger: ExitTrigger 

Expression:VerifyCreditInterface.verifyCreditEXIT/ComponentData/sca:TARGET_COMPONENT 

__162. Switch to the KPI Model Tab 

__163. Right click the module and select new KPI Context 

__164. Provide the name OpenAcct602Context and click Finish. The screen should appear as 
follows: 

__165.	 Save All changes by Ctrl+Shift+S 

__166.	 Next Generate the Monitor Java EE project, from the project explorer window expand the 
OpenAcct602MonitorProject, expand the Monitor Models folder and right click the Monitor Model 
and click Generate Monitor Java EE Project 
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__167. In the window that opens provide Target Project Names and click Finish. 

__168. Switch to the Java EE perspective 
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__169. Right click the created Monitor model application, and click prepare for deployment 

__170. Export the EAR file 

__171. Name the EAR file and save to the desktop. Uncheck Optimize for a specific server runtime. 
Click Finish 
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__172. Return to the WebSphere Process Server Administrator console, expand the Applications and 
select Monitor Models. 

__173. After clicking the installation button, browse and select the EAR file you just created. Click Next 
through the panels and accept the defaults and then click Finish. 
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__174. Save the changes to the Master Configuration 

__175. Start the EAR file 

__176. Expand the Security menu, select the Monitor Data Security, click root. 

__177. Select the Monitor Model, and select the Personal-KPI-Administrator and click Users. 
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__178. Click Search and add the Administrator User and click OK. 

__179.	 Repeat the previous 2 steps for the Business Manager user, Public-KPI-Administrator, and KPI-
Administrator. Click OK. 

__180.	 Switch back to WebSphere Integration Developer > Business Integration perspective. In the 
servers tab, right click the Fabric server and select Publish. 
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__181. Login into Business Space 

__182. Switch Perspective within Business Space 

__183. Create a New Area within Business Space 
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__184. Name the Business Space area and select from Template and press OK. 

__185. The Business Space should provide a template and Select the KPI Manager Tab. Select the 
Monitor Model – OpenAcct602MonitorModel and select New Aggregate KPI. 

__186. Name the KPI, Credit Requested for Equinox: 
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__187. Switch to the Range Tab and edit the Ranges by Adding Rows 

__188. Switch to the Definition Tab and select : 
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__189.	 Click OK and you should see a new entry ‘Credit Request for Equinox’ 

__190.	 Switch to WebSphere Integration Developer > Business Services perspective for this step only. 

__a. Double click Equinox under Endpoints 

__b. From the Endpoint Editor switch to the Protocol tab and copy the URL. 

__191.	 Switch back to Business Space and click ‘Credit Requested for Equinox’. 

__a. Switch to Definition tab and click Add for Data filter. 

__b. Place the copied URL as the value for the Endpoint Metric within the Definition tab. 

NOTE: Business Space does not provide the option for this metric if you do not save (click OK) before 
adding Data filter. 
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__192. Repeat the process for the Exterian and InternalDB endpoints. 

__193. Switch to the KPIs tab, click the down triangle to configure the widget. 
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__194. Select the KPIs that were just created and click OK 

__195. This should open the gauges as a dashboard widget. If the do not appear as such, click the ½ 
gauge icon at the lower left of the widget. 

3.3 Run solution on WebSphere Process Server 
You are ready to run the end-to-end JK Enterprises Open Account BPEL process. This process 
orchestrates three services that ValidateAddress, VerifyCredit, and ProcessApplication in order 
to open a new loan account. 
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Your goal is to validate that the correct credit report service provider is being selected and 
provisioned by the Dynamic Assembler for three use cases. 

Keeping things simple 

In this learning lab you are keeping things simple by 
focusing only on one service realization – the credit 
report service request. 
Both the address validation and application 
processing service calls, though driven by the 
Dynamic Assembler round-robin between equivalently 
ranked services. 
In real world enterprise class Component Business 
Services Applications, many service realizations and / 
or process invocations are driven using dynamic 
declarative policy based selection. 

__196. Switch to WebSphere Integration Developer’s test environment in order to run three test cases. 

__a.	 Switch to Business Integration Resource perspective using the menu bar by selecting 
Window > Open Perspective > Other. Select Resource and click OK. 

__b. In the Navigator tab on the left expand the OpenAcct602 resource folder and then expand 
the TEST_CASES folder. 

There are three previously configured test cases provided: 

TEST_Equinox_NEW_5000.wbiexetrace 

TEST_Exterian_EXISTING_15000.wbiexetrace 
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TEST_InternalDB_EXISTING_5000.wbiexetrace 

InternalDB test execution 

The InternalDB Web service is JK Enterprises’ internally developed and hosted credit report 
service. Recall that it stores reports for EXISTING customers but only supports credit requests 
for customers with SMALL account types – that is less than $10,000. 

__197. Run the test case for InternalDB service. 

__a.	 Double click TEST_InternalDB_EXISTING_5000.wbiexetrace to open the test 
environment. 

__b.	 Under the Detailed Properties section on the right, scroll down to locate and validate that 
the data elements and values are set. 

application.employee.type EXISTING 

application.requestedCreditLimit 5000 

Minimizing customer and employee address will help. 

__c. To run this test case, in the upper left portion of the Events test area, click Invoke to 
highlight it and then click the continue icon. 

2009 May, 21 IBM WebSphere Business Services Fabric 6.2 – Lab exercise	 Page 118 of 123 

LegacyBusinessApplication-Lab_2-AssembleAndDeployCBA.doc 



        

                

 

 

    

           
        

      

                
           

     

               
   

 

             
 

 

             
    

          

                

                 

© Copyright IBM Corporation 2009 All rights reserved 

First run is slow 

This first test run takes quite a while because the test 
infrastructure is being loaded and the application is 
being deployed to the process server 

__d.	 Each step in the invocation process will generate a request and response element. Locate 
the newly generated event response for the credit service response called: 

Response (OpenAcctBPEL < -- CreditCheckDA:verifyCredit) 

__e.	 Click this element to expose the response information in the Response parameters window 
to the right. 

__f. In the Response parameters table, examine the value for reportingEntity.name is 
Internal. 

As expected, the InternalDB credit reporting endpoint was selected. It even returned a 
credit score of 550. 

__198. Examine the logging provided by the Dynamic Assembler. 

__a. Double-click the Console tab at the bottom of the test window to maximize it. 

__b. Scroll up and locate the output information shown below. Then, examine the trace below it. 
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__c.	 Scroll down and read the logging information generated. 

With verbose logging turned on in this test environment, it is possible to see detailed steps 
taken by the Dynamic Assembler. 

__d.	 Double click the Console tab to return it to its original location. 

__e.	 Click the X to close the test window and click No when asked to save changes. 

Equinox test execution 

The Equinox credit reporting service is a vendor credit report service provider. JK Enterprises 
uses this service for both NEW and EXISTING customers but only when their account limit is 
considered SMALL – that is less than $10,000. 

__199.	 Load and run the second test case for validating Equinox credit service selection. 

__a. Double-click TEST_Equinox_NEW_5000.wbiexetrace to open the test environment. 

__b. Locate and validate that the data elements and values are set. 

application.employee.type NEW 

application.requestedCreditLimit 5000 
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__c. Click Invoke to highlight it, and then click the continue icon to start this test run. 

__d. Click the new event trace response for the credit service: 

Response (OpenAcctBPEL < -- CreditCheckDA:verifyCredit) 

__e. In the Response parameters table on the right verify that the reportingEntity selected is 
Equinox. 

__f. Click the X to close the test window and click No when asked to save changes. 

Exterian test execution 

The Exterian credit reporting service is the most expensive and best credit reporting service 
used by JK Enterprises at this time. They use it only for customer accounts that are considered 
LARGE regardless of whether customer is NEW or EXISTING. Today, JK Enterprises has 
policies in place that declare LARGE to be equal to or greater than $10,000. 

__200. Load and run the third test case to test for the selection of the Exterian credit service. 

__a. Double click TEST_Exterian_EXISTING_15000.wbiexetrace. 

__b. Locate and validate that the test data is correct. 

2009 May, 21 IBM WebSphere Business Services Fabric 6.2 – Lab exercise Page 121 of 123 

LegacyBusinessApplication-Lab_2-AssembleAndDeployCBA.doc 



        

 

                

 

    

    

                

            

     

        

 

                  

    
               

           
             
           

 

       
                

            
            

      

      
       
                
       

                
             
    

     

          
         
             

 
             

    

© Copyright IBM Corporation 2009 All rights reserved 

application.employee.type EXISTING 

application.requestedCreditLimit 15000 

__c. As before, highlight the Invoke element on the left and click the continue icon. 

__d. Click the new event trace response for the credit service. 

Response (OpenAcctBPEL < -- CreditCheckDA:verifyCredit) 

__e. Validate that the reportingEntity is Exterian. 

__f. Click the X to close this test window and click No when asked to save changes. 

You have deployed the model and metadata that you developed in Composition Studio to the 
runtime Business Services Repository. Then, you performedd three Open Account BPEL 
process runs on a live WebSphere Process Server. You verified that WebSphere Business 
Services Fabric’s Dynamic Assembler selected appropriate service realizations for each test 
case. 

What you should be able to do 
In the first part you have build out the Composite Business Services Model using the Composition 
Studio perspective. You have understood how and why WebSphere Business Services Fabric 
captures endpoint service realizations. You also verified the integrity of your model. 

These are the steps you completed: 

•	 Review Business Services Fabric Model 
•	 Create a Composite Business Service Model 
•	 Capture the Equinox service realization (two other credit reporting service were done for you) 
•	 Verify the Business Service Model Integrity 

In the next part, simulations allowed a developer of a Business Services Application to test, validate, 
and understand how the WebSphere Business Services Fabric’s Dynamic Assembler will perform at 
run time. 

In that part you completed: 

•	 Reviewed the capabilities of each credit reporting service endpoint 
•	 Defined these capabilities as assertions for each endpoint 
•	 Reviewed the JK Enterprises business policy for retrieving credit reports from different
 

providers
 
•	 Created and assigned a context specification for a specific Dynamic Assembler component 

in the process model 
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•	 Defined these policies in WebSphere Business Services Fabric using Composition Studio 
•	 Used Policy Simulator to validate the expected behavior of the Business Services Application 

you are developing 

In the last part, you setup the test environment and then ran saved test cases on WebSphere 
Process Server. You observed WebSphere Business Services Fabric’s Dynamic Assembler select 
the appropriate credit report service. This best endpoint selection was driven by declarative policies 
you implemented for JK Enterprises and the content, context, and contract of the service requests. 
You also explored how WebSphere Business Services Fabric extends IBM’s SOA Foundation using 
WebSphere Process Server. 

In that part you did: 

•	 Deployed, rand, and evaluated the results of three end-to-end test cases run on WebSphere 
Process Server 

•	 Understood how WebSphere Business Services Fabric enhances and extends WebSphere 
Process Server 

You have successfully completed all the labs. 
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